Best Practices for Workspace Design in Oracle RightNow Dynamic Agent Desktop Cloud Service
Introduction

The powerful workspace feature in the Oracle RightNow Dynamic Agent Desktop Cloud Service provides many options for configuring the editors that are used to create and edit records. However, if used incorrectly, workspaces can be difficult and inefficient for agents. Administrators may find poorly designed workspaces difficult to maintain, and poorly designed workspaces may exhibit dramatically reduced performance and lead to data inconsistency.

This guide is intended for administrators who are creating and maintaining workspaces. It describes several best practices and provides tips to help you optimize your workspaces to maximize agent productivity, minimize errors in data input, enforce consistent user interactions, and make the maintenance of workspaces easier.

To get the most out of this document, you should have a working knowledge of workspaces and have read the documentation for them. In addition, you may also find the Answers Web pages about workspaces helpful.

This document does not cover best practices for other Oracle RightNow Dynamic Agent Desktop Cloud Service features used in conjunction with workspaces, such as Oracle RightNow Agent Scripting Cloud Service, Oracle RightNow Guided Assistance Cloud Service, Oracle RightNow Desktop Workflow Cloud Service, or add-ins for desktop integration components. Best practices for those products and how they best interact with workspaces are covered in the following guides:

- Best Practices for Designing for Context with Oracle RightNow Desktop Workflow Cloud Service
- Best Practices for Designing Contact Center Experiences with Oracle RightNow CX Cloud Service
General Tips on Workspace Design

The following best practices will guide you in using all the workspace options to create usable, efficient, and easy-to-maintain workspaces.

Managing Workspaces

To more easily manage your workspaces, especially if you have many workspace administrators editing them, use the following tips:

- Give your workspaces logical and descriptive names, and use a consistent naming convention.
- Organize the workspaces into folders in a logical manner. For example, put all the workspaces used by particular profiles into profile-specific folders.
- Give other workspace administrators a heads-up before making changes to a workspace. If two people edit a workspace at the same time, they will most likely overwrite each other’s changes.
- Add notes to the workspaces, describing what they are used for. Also, add a note whenever you make a nontrivial change. Put your name in the note, in case someone has questions about the change.
- Decide on a process for managing workspaces that are still in development and not yet deployed. For example, prefix their names with “(In Development)” or put them in a specific In Development folder.
- Don’t leave old, unused workspaces around—delete them, or put them into a specific old-workspaces folder to reduce clutter and confusion.
- Use the standard reports in the Public Reports -> Common -> Site Administration -> Workflow folder to see which workspaces are used and by whom.
- Reference the audit log to see who has edited a workspace and when each edit was done.

Workspace Layout

When designing your workspaces, carefully consider the placement and order of fields and controls. Put the most-important fields in the summary panel (above the tabs) in the order that makes the most sense for your business. Gather the rest of the fields into logical groups, and put them on one or more tabs. Controls are also most often put on separate tabs, but in some cases, it might make sense to have several controls on the same tab. For example, if your incidents often don’t have many attachments, you can consider combining the file attachment control with the audit log control on the same tab. When you have determined the tab content, make sure the tab order is logical, so the most-frequently-used tabs come first.
Tab Indexes
Make sure to set the tab indexes for fields so you can quickly enter data without having to use the mouse to navigate between fields.

Shortcut Keys
For fields that are used frequently, define a shortcut key for the fields, so that agents can quickly navigate to them.

Labels
If the default label for a field is inappropriate for your use case, consider changing it to something more appropriate. Long labels may make the column very wide. If you can’t think of a way to abbreviate or shorten the label, you can show the label above the field (set the label position to Top, and align the text to the left).

Per-Profile Settings
If you have different profiles with slightly different field permissions, consider having them all use the same workspace and configure the fields to be required/hidden/editable at the profile level. It will be much easier to maintain a single workspace with field profile settings than to maintain one workspace per profile.

Workspace and Business Rules
Oracle RightNow Contextual Workspaces Cloud Service is a very powerful add-in option that gives you the ability to tailor your workspaces to meet complex enterprise business needs. It can also make your agents more productive, by providing them with what they need, when they need it. For example, you can show only the information and fields that are relevant, based on

• What type of interaction it is
• Who the customer is
• Who the agent is
• What is happening during the interaction

Controls Default State
In many cases, a workspace contains many fields or controls that are applicable only in certain scenarios. Set the default state (visibility, required setting, and read-only setting) to match the most-common cases, and then use rules to handle the uncommon cases by dynamically showing/hiding/changing required or read-only settings. When using rules to show or hide multiple fields/controls, try to group these items onto tabs or panels and hide/show just that tab or panel. By following these best practices, you will make your rules easier to maintain and you will minimize workspace flickering that can happen when you first show and then hide fields and controls.
Managing Rules

To more easily manage your rules,

- Give them logical and descriptive names, and use a consistent naming convention for all your rules.
- Order the rules in a logical manner—for example, group rules that have the same trigger(s).
- Document your rules by adding a note to each of them.
- Before adding a new rule, check to make sure you don't already have a rule with the same trigger and condition. If you do, add more actions to that rule instead of creating a brand-new rule.
- Print rules out or export them to Excel if you have many rules and find it difficult to manage them from within Workspace Designer, a feature of Oracle RightNow Dynamic Agent Desktop Cloud Service. On Workspace Designer’s Home tab, click the Rules button, and then in the Options dialog box, select Print/Export.

Rules Performance

Will having many workspace rules slow down your workspace? The answer depends entirely on the triggers, conditions, and actions your rules have. If you have many rules triggered by the same event (for example, when the editor loads) and if all the rules’ conditions evaluate to true (or if the rules don’t have conditions), all these rules’ actions will execute, which may slow down the workspace. For example, if several rules end up alternating showing/hiding a tab, flickering may occur. In such cases, you can consolidate the rules so you don’t have duplicated actions executed at the same time. On the other hand, if you have many rules that are each triggered by separate events, that should not have a noticeable performance impact on your workspace.

Business Versus Workspace Rules

What’s the difference between server business rules and workspace rules?

- **Time of rule execution.** Business rules execute when you save (create or update) a record. Workspace rules can change data inside the workspace before the records are saved (but for the changes to take effect in the database, the record eventually has to be saved).

- **Scope of rules.** Business rules execute for all sources that can save a record, such as Oracle RightNow Dynamic Agent Desktop Cloud Service, Oracle RightNow Customer Portal Cloud Service Web pages, and integrations. Workspace rules execute only for the agents whose profiles use the workspace that has the rules.

- **Business and workspace rules support slightly different conditions and actions.** For example, you cannot send e-mails from workspace rules but you can from business rules.
Business and Workspace Rules Interaction

How do server business rules and workspace rules interact? The short answer is that they don’t—they have no knowledge of each other. For example,

- While you are working on a record, one or more workspace rules may execute and change data.
- When you save, the editor temporarily becomes disabled (unless you save and close when the editor is closed).
- The data is sent to the servers that are part of Oracle RightNow Platform; once the data has reached those servers, one or more business rules may execute and change data.
- The data is then saved to the database and sent back to the editor.
- The editor is refreshed with the updated data, and it becomes enabled again.

No workspace rules are executed while the editor is disabled, not even if business rules change fields and you have workspace rules that are triggered by those field changes. However, right before the editor becomes enabled, workspace rules triggered by “The record is saved without closing” are executed.

Business and Workspace Rules Usage

When should you use server business rules, and when should you use workspace rules? In many cases, you can use either. Use the preceding information to decide what will work best in your particular situation. For example, let’s say you want a field to be set according to the value of another field. If you want this to happen only when particular agents use a certain workspace, a workspace rule will work well. But if you want this to happen for many agents using different workspaces and also when your integrations update records, using a business rule will be better.

Tips for Specific Controls

The following section comprises best practice tips for using various specific controls.

Ribbon

- **Ribbon content.** Edit the ribbon for your workspaces, and make sure it contains only buttons that agents actually need to use.
- **Info button.** To reduce clutter on your workspace, consider configuring the Info ribbon button to show fields that are always read-only—for example, to show an incident’s Created and Updated dates.
- **Links button.** If agents often need to open specific Web pages while using a workspace, consider adding links to those pages to the Links button. You can also add browser controls to the workspace and point them to the Web pages, but that may increase your workspace load time (see more information on this topic below).
Tabs

- **Tabs for tasks.** For usability reasons, it is often a good idea to use different tabs for different tasks. For example, in addition to a base tab containing an incident discussion thread, you could create another tab with fields commonly used to solve technical issues. Additional tabs could contain layouts for resolving billing issues, tracking and returning orders, soliciting feedback, or creating tasks. Note, though, that Workspace Designer shows only the initial tab order, because the order is stored on an agent-by-agent basis and agents can reorder it any way they want. Turning this behavior off is a matter of unchecking the Allow Tab Reordering option for the tab control.

- **Tab content.** Make sure fields often used together are on the same tab, to minimize having to switch between different tabs when entering data.

- **Nested tabs.** Use nested subtabs judiciously—they can be great for organizing a lot of fields, but they can also make information difficult to find.

Tables and Panels

- **Table usage.** Table controls are useful for organizing larger areas into smaller logical sections. Setting table properties such as foreground and background color and border style can help differentiate a table from other sections of your workspace. However, be judicious in using tables—especially nesting tables. In some cases, it is not necessary, and having many nested tables may increase your workspace load time.

- **Panel usage.** Panels are similar to tables and can be useful if you need to define a section that cannot be smaller than 100 pixels vertically (the minimum height of a panel).

- **Tables versus panels.** Note that whenever you add content to a panel, the system will automatically create a table inside the panel to hold your content. As a consequence, tables are almost always better than panels, because adding a panel may simply result in a redundant control.

- **Row Span/Column Span.** Setting the Row Span and Column Span properties for a control inside a table can be useful for aligning controls and making them take up more space relative to other controls in the table.

- **Show Outline.** To more easily see a table’s layout when designing a workspace, you can click the Home tab’s Show Outline button, which draws the outline of each cell in the table.

Browsers

- **Browser control and Internet Explorer.** Browser controls use components of the Internet Explorer browser installed on your computer. This means that the version of Internet Explorer you have installed may affect the behavior of the browser control. In addition, most Internet Explorer settings (such as cache settings) also affect browser controls in workspaces. Finally, if you have
Best Practices for Workspace Design in Oracle RightNow Dynamic Agent Desktop Cloud Service

trouble running a certain Web page in Internet Explorer, it will most likely not work well in a browser control inside a workspace either.1

- **Delay Page Load.** Try to set the Delay Page Load property for all your browser controls. This will make sure the browser page is not loaded until the browser control becomes visible, which will reduce workspace load time and improve memory usage. If you have desktop integration JavaScript code on a browser page, however, you may always have to load the page by disabling the Delay Load functionality.

- **Memory usage.** The memory usage of the browser control, and hence the memory usage of the workspace, is based on the content of the page being displayed. Hence, try to minimize the complexity of Web pages. Also note that some Web development libraries, such as jQuery, may have memory leaks when used in certain scenarios—that is, they use memory that is never released back to the computer, eventually causing performance problems. So, if your Web browser control pages utilize such libraries, Oracle RightNow Dynamic Agent Desktop Cloud Service may use more and more memory, which will degrade performance and force you to restart the application.

- **Web page location.** The Web page used by the browser control can be put on a Web server, on the agent’s local computer, or at a shared network location. The first option is the most common and is your only option if you want the page to be dynamically generated (using information from a database). Keeping the page on a local computer can work well for static HTML pages that contain, for example, desktop integration JavaScript code. However, it might be difficult to ensure that all agents have the file properly installed on their computer. Pages at a shared network location may cause performance problems, because network sharing can often be quite slow.

- **Minimizing the number of browsers.** Because every browser control on your workspace uses a fair amount of memory, it makes sense to minimize the number of browsers, to reduce memory usage and improve performance. Here are a few ideas:

  - As mentioned above in the “Ribbon” section, consider using the Links ribbon button instead of the browser control.

  - Instead of showing two or more browser controls next to each other, combine the two pages into one, using frames, and put them into one browser control. Here’s the HTML code for putting two Web pages on top of each other, using frames:

1 For detailed information about the Internet Explorer/browser control relationship, see msdn.microsoft.com/en-us/library/aa741312(VS.85).aspx.
• If you don’t need to have all the pages open at the same time, you can replace several pages with a launch page (a page that contains links to the other pages). Here’s some example HTML code for a launch page that shows two links to other pages:

```html
<html>
<head>
<title>Page with links</title>
</head>
<body>
<a href="http://www.google.com">Go to Google</a>
<a href="http://www.yahoo.com">Go to Yahoo!</a>
</body>
</html>
```

With the workspace rule action for setting the URL for a browser control, you can, in some cases, have one browser control and dynamically point it to the appropriate Web page, instead of having multiple browser controls pointing to different pages.

Reports

• **Custom reports.** The default reports used by the workspace relationship items and search controls are designed to handle the most-common business use cases. If they are not sufficient, you can copy the standard reports, add or remove columns, or add more filters.

• **Standard reports.** It may make sense to copy the standard reports and use the copies even if you don’t have any immediate plans to actually change the reports. The reason is that the workspace itself may be copied and modified multiple times, and you might want to change a report someday. If the workspaces then use a standard report, you will have to edit multiple workspaces and replace the report. If you had used a copied report to begin with, you could simply change the report and the change would be reflected in all the workspaces.

• **Report location/permission.** You may want to save reports used in workspaces in a special workspaces folder in the Report Explorer feature of Oracle RightNow Dynamic Agent Desktop Cloud Service and limit the edit/open permissions for them. You may even want to make the reports private so that only you can edit them (workspaces can use reports regardless of their permission, even if they are private).
Best Practices for Workspace Design in Oracle RightNow Dynamic Agent Desktop Cloud Service

- **Delay Report Execution.** Try to set the Delay Report Execution property for all your report controls. That will ensure that reports run only when they become visible, which will reduce workspace load time and improve memory usage.

- **Optimize reports.** Make sure reports are optimized and show only necessary information.

- **Customize commands.** To configure the buttons available on the report controls toolbar, edit the report and click the **Records** button on Report Designer’s **Home** tab. Report Designer is a feature of Oracle RightNow Dynamic Agent Desktop Cloud Service.

**File Attachments**

- **Security.** If there is a potential for harmful content to be included in file attachments, a good safety measure is to turn off the FATTACH_OPEN_ENABLED configuration setting. That will ensure that attachments are not automatically opened.

- **Prevent deletion.** You can prevent attachments from being deleted by turning off the file attachment control’s Allow Delete option.

- **File size limit.** Set the FATTACH_MAX_SIZE configuration to limit the size of the files you can upload. The default setting is 20,971,520 (20 MB), and the maximum is 125,829,120 (120 MB).

**Workspace Performance**

Apart from loading record data from the database, workspace loading consists mostly of reading the workspace definition and creating the controls on the workspace. Note that all controls are created, whether or not they are initially visible. Therefore, to maximize performance, it is best to make the workspace as simple as possible. Here are some more detailed tips on how to get better performance:

- Try to avoid having an excessive number of fields in a workspace.

- Try to avoid having excessively nested containers, such as many levels of tabs or nested tables.

- Try to avoid having so much vertical content that a scroll bar is needed.

- Try to avoid having an excessive number of workspace rules triggered by the same event (especially rules that get triggered when the workspace loads).

- For some controls that take a long time to load, use the Delay option, which delays rendering the display of the item’s contents until the item becomes visible.

  - For report controls and reportlike relationship items, this is located on the **Design** tab under Report Behavior and is called Delay Report Execution.

  - For the browser control, it is on the **Design** tab and is called Delay Page Load. The Delay option is set by default when you add the above controls to a workspace.

- Minimize the number of browser controls on the workspace. See the “Browsers” section above for detailed information.

- Make sure the reports are optimized and that they show only necessary information.
Testing and Applying Changes

The main tool for testing your workspaces before deploying them is to use the Preview functionality. Note, though, that Preview shows the workspace behavior only for users with the same profile—if you have workspace rules that do different things according to the user’s profile, you can test everything only by logging in multiple times as different users and previewing as each user. In certain cases, it can be easiest to test simply by creating test profiles/accounts, deploying the workspace to the test profile, and then logging in by using the test account and creating/editing records.

In some cases, you may not want to modify and test a workspace that is currently in use by agents. Also, when deploying the changes, you may want to easily change all existing uses of a workspace to refer to the updated one. Here’s a trick for doing this:

1. Copy the workspace you want to change.
2. Associate it with a test account/profile.
3. Make the changes to the workspace, and save it.
4. Test the workspace by creating/editing incidents, using the test account.
5. Repeat steps 3 and 4 until you are satisfied with the results.
6. Copy the modified workspace. When prompted with a name, select the original workspace you copied in step 1. This will effectively replace the original workspace with the new, updated one.
7. Remove the copied workspace created in step 1 (optional).

If you can test your changes with the Preview functionality, you can skip step 2 and do the preview instead of step 4.

Conclusion

It is recommended that you review all your existing workspaces and make sure to follow the best practices outlined in this guide. By applying these proven tips on workspace design, rules, controls, and performance, you will optimize your workspaces. Problems in maintenance and performance can be avoided, and you will ensure that your workspaces are usable, efficient, and easy to maintain.